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A free EFM32 development IDE
based on Eclipse for Windows

ANO0023 - Application Note

Introduction

This application note will show you how to set up a simple project in Eclipse, how
to generate the code and finally debugging the code on an EFM32 microcontroller.

This application note includes:

* This PDF document

» Eclipse support files (zip)
e Zylin Embedded CDT plugin
* Eclipse Embedded Systems Register View (EmbSys) plugin
» Eclipse Cortex cpu register view patch
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1 Prerequisites

You will need a "Gecko Starter Kit" (STK) or "Gecko Development Kit" (DK) and the following tools:

» Eclipse IDE for C/C++ Developers.

» CodeSourcery Sourcery G++ Lite, the GNU toolsuite containing gcc compiler/linker and gdb debugger.

« Zylin Embedded CDT plugin, makes debugging of embedded targets with Eclipse easier.

» Eclipse Embedded Systems Register View plugin (EmbSys). Eclipse view of peripheral registers of
all Energy Micro EFM32 parts.

* SEGGER J-Link software and documentation pack which contains SEGGER's J-Link GDB Server.
The GDB server interfaces the gdb debugger to the target debug probe for EFM32 parts.

e Energy Micro's EFM32 energyAware Software. It contains the SW examples and energyAware
Commander which is used to program the flash memory of EFM32 parts.

1.1 A note on versions

To succeed in making your complete setup work, it is important to notice that since there are many
different tools from different sources involved, you should use the versions shown in Table 1.1 (p. 2)
. Once you have a stable setup, you can experiment using other tool versions. Microsoft Windows 7
Professional (64bit) was used to prepare this application note.

Table 1.1. Tool version information

Eclipse IDE for C/C++ Developers Version: 3.4.2 Build id: M20090211-1700 (Ganymede)

CodeSourcery Sourcery G++ Lite 2010qg1-188

gcc version 4.4.1
gdb version 7.0.50.20100218-cvs

Zylin Embedded CDT 4.15.1
Eclipse Embedded Systems Register View 0.1.6
SEGGER J-Link GDB Server V4.20h
Energy Micro energyAware Commander 2.0

1.2 Installing the tools

1.2.1 J-Link software and documentation pack
Install the J-Link software and documentation pack. It is available from:
http://lwww.segger.com/cms/jlink-software.html

Unzip the file and run the installer executable. You might get prompted if you have an older version of
JLinkARM.dll installed on your machine. You should select to overwrite older versions.

It is now time to connect the STK to your machine via the supplied USB cable and check that the J-Link
device driver was properly installed.

Create a shortcut on your Desktop to SEGGER's J-Link GDB server. You will find this program in
Windows' Start menu under SEGGER->J-Link ARM V4.20h. Modify the shortcut properties to:

"C:\Program Files (x86)\SEGGER\JLInkARM_V420h\JLinkGDBServer.exe" -if SWD
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The extra parameters direct the GDB server to use SWD instead of JTAG when communicating with the
microcontroller. If everything is OK, the server GUI should look like:

Figure 1.1. J-Link GDB Server GUI

<3 SEGGER J-Link GDB Server V4.20h

File Help
GDE I\-\-"aiting for connection I Initial %D speed |5 kHz "l v S
_ [~ Show log window
J-Link IConnected I Current SWD speed |5 kHz [~ Gensrate logfile

y - - - ~1 [ Cachersads
Target [ConexM3, Core I 0x00000000 | [~ 315% [ [Big endian ~] i

v Init regs on start

o Bytes downloaded |1 ITAG device |

Do not exit this program before continuing.

1.2.2 Energy Micro example SW and tools

Install the package energyAware EFM32 Gecko DK Installer. A complete software and documenation
bundle for DK and STK. It is available from:

http://www.energymicro.com/downloads/software

Unzip the file and run the installer executable. Files will be installed as shown in the figure below. Pay
special attention to the blink example and energyAware Commander, as we will use these later in this

application note.

WWW.energymicro.com
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Figure 1.2. energyAware EFM32 Gecko DK file structure
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E 7 Adobe
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E | CodeSourcery
E [ JCommen Files
H [ Creative
= Dell
[T Dell DataSafe Local Backup
H 7 Dell DataSafe Online
H= 7 Dell Support Center

Bl Energy Micro
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B = EFM32 Gecko DK
B[ Jboards
E [ JEFM32_Goo DK
B[ JEFM32_Giooe STK
E [ metadata
[(Cbsp
& _Jbspdoc
[[Tdrivers
B Jexamples
E [ metadata
B Jblink
[Jam
H | codesourcery
|:|ia'
[Drowley
H [ Jdock
[ CortexCpuRegs
B Jemlcd
H [ Jemode
& [ Jenergy
H [ Jtouch
& [ Juserpage
E | Cmsis
H [ Jdecs
H [ Jefm3Aib
[ JenergyAware Commander
[ JenergyAware Designer
E [ JenergyAware Profiler

[

To verify target connectivity, start energyAware Commander. You will find this program in Windows' Start
menu under Energy Micro->energyAware Tools. We will be using this tool later to download code to the
STK's flash memory. Try the Connect button and verify that Board Information and MCU Information

frames are updated with meaningful information.
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Figure 1.3. energyAware Commander, Connect status

= energyAware Commander -0l x|
File Help
JJ Disconnect ||J—Link Device IUSB #0 'I |J—Lir1k Speed |4DI3II3I kHz vl |
- - —Update Kit
m Installation package
E I Browse... |
b ’ Install Package |
Kit
—Board Information
g
= H Board: EFM32 Gecko Starter Kit
= = BRO2001A rev, ADD
LLLLLL] Hardware version: 1v0
Flash Firmware version: 1v2pib4
FPGA version: M/A
Debug Mode: IMCU LI
USE Address: jusB =0 |
—MCU Information
Files ) :
Chip Type: EFM32GE90F 125
& Chip Revision: 1B
i 3 Production Id: 6
i
hﬁl Flash Size: 128 KB
",-" SRAM Size: 16KB

Demos

[Energy Micro EFM32 compiled Aug 27 2010 16:12:09 5

Exit energyAware Commander.

1.2.3 CodeSourcery Sourcery G++ Lite

Install the CodeSourcery Sourcery G++ Lite software package (make sure you download the Windows
version). It is available from:

http://www.codesourcery.com/sgpp/lite/arm/portal/release1294

When prompted with a question to add CodeSourcery to the PATH environment variable, you should
accept.

1.2.4 Eclipse IDE for C/C++ Developers
Eclipse is available from:
http://eclipse.org/downloads/packages/eclipse-ide-cc-developers/ganymedesr2

As Eclipse is a Java application you must have Java Runtime Environment (JRE) installed on your
computer before installing Eclipse. You can check if Java is installed by issuing the command:

java -version

in a Command Prompt window, or you can visit http://java.com and click on the link named
Do | have Java?
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When downloading Eclipse make sure you select the Windows version. In this application note we use
the Ganymede edition. Other versions tested:

» Europa. OK, briefly tested.
* Ganymede. OK, recommended.
» Galileo. OK, briefly tested.

* Helios. Does not work. We did not succeed in getting the new feature GDB Hardware Debugging to
work.

Unpack the zip file at c:\ and you have a full Eclipse installation at c:\eclipse. The two plugins we will
be using can be installed by unzipping an0023_efm32_eclipse_toolchain.zip or by following the more
official procedure outlined in the next two sections. If you elect to use the plugins in the zip file, copy the
relevant files into eclipse's features and plugins subdirectories (under c:\eclipse). This directory structure
is replicated inside the zip file.

Figure 1.4. Eclipse plugins file structure

& [ Jeclipse =
B[ Jfeatures
[Jcom zylin_cdt feature 4.15.1
[Jong.edipse cdt_embsysregview _feature_0.1.6
= =plugins
[Jcom _zylin_embeddedcdt_4_15.1
El [ Jerg.edipse cdi_embsysregview 0.1.6
= Jdata
B[ Jcortex-m3
[ EnergyMicro
3 LuminaryMicro
]
[JSTMicro
Di::ons
[T Meta-inf
E(Jorg
Bl [Jeclipse
B Jedt
Bl embsysregview
[Jpreferences
Dvim ;I

1.2.4.1 Zylin Embedded CDT plugin

Start Eclipse by executing c:\eclipse\eclipse.exe. When prompted for workspace select C:\Program
Files (x86)\Energy Micro\EFM32 Gecko DK\boards\EFM32_Gxxx_STK\examples (we will need this
later). You will now be greeted by Eclipse's welcome screen.

Select Software Updates... from the Help pulldown menu, select the Available Software tab and push the
Add Site... button. Enter http://opensource.zylin.com/zylincdt as Location. After pressing the OK button,
select Zylin and push the Install... button as shown in the figure below.
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Figure 1.5. Zylin Embedded CDT plugin installation

& software Updates and Add-ons _ 1Ol x|

Installed Software  Available Software |

Itype filter text - Install... |

Mame I i [install the selected ite
a ﬁ-ﬂ EPP Usage Data Collector Update Site Properkies |

O a Ganymede Update Site
O a http: ffdownload. edipse. org/tools fcdt releases fganymede
O a http: ffembsysregview. sourceforge.netjupdate Add Site... |
[ <] Mylyn for Edipse 3.4, 3.5 and 3.6 =
O a The Edipse Project Updates Manage Sites... |
= [ %] zylin cOT site

=l 000 Zylin Embedded COT

[#] 5 Zyiin Embedded COT 4,151 Refresh |

1 ]
¥ Show orly the latest versions of available software
¥ Indude items that have already been installed

Open the 'Automatic Updates' preference page to set up an automatic update schedule.

-
(2
W

The installation process may take a while... When asked for restarting Eclipse, do so.

1.2.4.2 Eclipse Embedded Systems Register View plugin

Proceed as described in the previous section, but use http://embsysregview.sourceforge.net/update as
Location.

Restart Eclipse when asked to do so.
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2 Working with Eclipse

Now it's time to continue with Eclipse. Close Eclipse's welcome screen tab and Eclipse's Workbench
view appears:

Figure 2.1. The Eclipse Workbench View

Il

File Edit Refactor Navigate Search Run Project Window Help

| wi - |E-&--G-[8-2-|3%-0-&-|[@=c - [ |-G - E e

[ Project Explorer 53 =0 = O 5 outin 52 @Mahe]zﬁ
=R il

@

An outiine is not available.

[%1 Problems £2 | Tasks} El Consolew B Propertieq
0 items.
Description_ = [Resource [ Path | Location [ Type [

[ |

2.1 Create a project

We will create a project based on the blink example provided within the energyAware package already
installed.

Create the project by selecting File->New->C Project. Use blink as project name (same name as
the project directory). Make sure that your Project type is a Makefile project with Toolchains: -- Other
Toolchain --. Hit the Finish button to complete the project definition.

Now we will fine-tune some project properties. Select Project->Properties:
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Figure 2.2. The Eclipse Project Properties window
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|ty|:-e filter text C{C++ Build - T
- Resource
i Builders
=8 C/C++ Build Configuration: IDefault j Manage Configurations...
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- Project References
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- RunDebug Settings
[+~ Task Repository

[Z] Builder settings | (®) Behaviour

- Settings
- Tool Chain Editor —Builder
- CfC++ General
c Builder type: IExternaI builder j

[~ Use default build command

Build command: I cs-make

Variables. .. |

—Makefile generation

¥ | Expand Env. Yariable Refs in Mal
||

[ | Generate Makefiles automatically

rBuild location

Build directary: | &{workspace_|oc: blink fcodesourcery}

Workspace... | File system... | Variables... |

Restore Defaults | Apply |
7 oK I Cancel |

Do the following modifications:

e C/C++ Build: Do not use default build cmd, uncheck the checkbox and modifiy build command to cs-
make.

» C/C++ Build: Modify build directory to ${workspace_loc:/blink/codesourcery}.

e C/C++ Build->Discovery Options: Uncheck the Report path detection problems and Automatic
discovery of paths and symbols checkboxes.

» C/C++ Build->Settings: Check the GNU EIf Parser checkbox.

Hit the OK button to complete project property fine-tuning.

We also need to make some changes in the makefile. Make a copy of the original Makefile.blink in the
blink/codesourcery directory and save it with filename Makefile. These operations are easily performed
by right-clicking on the files in the Project Explorer pane and selecting Copy and Paste. Open Makefile
by double-clicking on it in the Project Explorer, then change:

TOOLDIR ="C:/Program Files (x86)/CodeSourcery/Sourcery G++'
to
TOOLDIR ="C:/Program Files (x86)/CodeSourcery/Sourcery G++ Lite'

Also check that the CFLAGS macro contains option -O0. The -O<n> option select code optimization
level. Using -O0 makes it easier to use the debugger. Also make sure that the project name defined with
the PROJECTNAME macro has the same name as the project root directory:

PROJECTNAME = blink

2.2 Build the code

Now you are ready to build the code. Select Build Project or Clean... from the Project menu, or simply
use Ctrl-B from the keyboard. The output from the build process is visible in the Console tab.

WWWw.energymicro.com
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2.3 Download application code to target

To execute the application code on the target cpu, we must program the flash memory in the EFM32
microcontroller.

You can do this using energyAware Commander. Hit the flash symbol and browse to the correct location
of your blink.bin file (it will reside in the codesourcery/exe subdirectory of your project. Hit the Flash
EFM32 button to download the application.

Figure 2.3. energyAware Commander, flash command

il
File Help
| Disconnect ||3ink Device [USE =0 -] |sink Speed [4000 kriz =l

~Flash EFM32

- Binary File
; l:kc: DK fboardsEFM32_Gux_STE fexamples blink fcodesourcery fexe fblink, bin Browse... |
[V Reset EFM32 after flashing W Verify upload  Flash EFM32 |

—Flash Erase/Mirite Protection

Write protect flash range [ MR N e 2=

Resetting EFM32...
ANRNRNRNRNRNRNNNNNNNNNNNNNENNRNNNDN] o5

Cancel

—Debug Lock Tools

The unlock function anly w
Unlocking the chip will eraseamoata o IEsT G SART,

Unlock debug access | Lock debug access |

Demos

|Energy Micro EFM32 compiled Aug 27 2010 16:12:09 i

A more elegant approach is to define an External Tools configuration. Open the pulldown menu of the
External Tools button:

Figure 2.4. External Tools button

R-|®@c - |0 C

o launch history )

Run As 3

External Tools Configurations...
Organize Favorites...
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and select External Tools Configurations.... Highligth Program and hit the New launch configuration

Figure 2.5. Creating a new external tools launch configuration

& External Tools Configurations

Create. manage. and run confiqurations

Run a program

|
>
T,
il
=a A | Configure launch settings from this dialog:
I‘]New launch configuration |
e

----- R ¥Program]

Ij - Press the 'Mew' button to create a configuration of the selected type.

- Press the 'Duplicate’ button to copy the selected configuration.

= ¥ (i

- Press the 'Delete’ button to remove the selected configuration.

- Press the 'Filter' button to configure filtering options.

- Edit or view an existing configuration by selecting it.

Configure launch perspective settings from the Perspectives preference page.

Filter matched 1 of 1item

Fill in as shown in the figure below, cut and paste from here :

C:\Program Fil es (x86)\Energy M cro\EFM32 Gecko DK\ energyAware Commander\ eACommander. exe
-v -f "${workspace_| oc:/ ${proj ect _nane}/codesourcery/ exel ${ proj ect _nane}. bi n}"

e -v turns on verify

» -f specifies the file with the target binary.
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Figure 2.6. External tools configuration details

& External Tools Configurations il

Create. manage. and run configurations Q
i,

Run a program
prog gl

o -+
= . .
LY 2 & | H Name: IFIash Binary

type filter text
! [=] Main ™7 R.efresh\l B Build\l w Emfironmenﬂ = gmmorq
-4 Ant Build Location:
= % Program = :
% P — | C:'Program Files {x86)\Energy Micro\EFM32 Gecko DK\energyAware CommandereACommander,exe
Browse Workspace. .. | Browse File System... | Variables.., |
—Working Directory:
Browse Workspace. .. | Browse File System... | Variables... |

— Arguments:
-y -f "&{workspace_loc: f${project_name}/codesourcery fexe/S{project_name}.bin}”

-
[ -
Variables... |

Mote: Endose an argument containing spaces using double-guotes (7.

Apply | Revert |

Filter matched 3 of 3 items

) Run Close |

Do the following modifications in the other tabs:

* Build tab: Uncheck Build before launch checkbox.
» Common tab: Check External Tools checkbox in the Display in favorites menu frame.

Now you can download code by selecting Flash Binary from the External Tools button dropdown menu.
Note that Eclipse will expand the argument macros correctly only if your project is highligthed in the
Project Explorer tab. (Hint: You can open a Project Explorer tab in Eclipse Debug view too. More on
debug later).

Check the output in the Console tab in the figure below. It shows the result of a succesful flash operation.
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Figure 2.7. Downloading code

& C/C++ - blink/blink.c - Eclipse Platform -0 x|
Ele Edit Refactor Mavigate Search Run Project Window Help
In-Felaldg-e8-d-8-|&-8-(35-0-4-|®@cy-[[40B |3 -5 -6 - [ %5 Debug |ERc/c++
[ Project Explorer 53 = 0[5 outine 3 MalveTargEtsw =0
d laz S '&s @ | i
=5 blink ~fl stdnth
B34 Binaries LBl stdbool.h
' 1
& am void Delay (uint32 t dlyTicks) ;B diph
(z= codesourcery : - wofll efm32h
& e uint32_t curTicks; l‘v feds.h
(= rowley - @Y maTicks : volatie uint32_t
blin:c curTicks = msTicks: - : Sy‘s'ﬁdc_Handler(vmf:}:unid
readme, txt while ((msTicks - curTicks) < dlyTicks) ; Delay(uint32.£) : voi
) oo @ main{void) ¢ int
int count = 0;
* Chip errata +/
CHIP init():
/* Ensure core frequency has been updated
SystemCoreClockUpda H
* Setup SysTick Timer for 1 mgeg interrupts =
if (SysTick Config(SystemCoreClock / 1000)) while (1) ;
f* Initialize LED driver */
LED Init():
/* Infinite loop */
while (1)
i
LED Value (count):
count++;
Delay(100) ;
}
il LA
1% Problems [ v Tasks | E] console 52 Epmpem'es) X% e8| tB8-5-=0
<terminated > Flash Binary {eAC) [Program] C:\Program Files (x86)\Energy Micro\EFM32 Gecko DK'er Commander\g; nder.exe
energyhware Commandsr 2.0 =]
Flashing "C:\Program Files (x86)\Energy Micro\EFM32 Gecko DK\boards\EFM32 Gxxx STK\examples\blink\codesourcery\exe\blink.bin"
Uploading flashloader...
Waiting for flashloader to become ready...
Flashing EFM32...
Finished!
il _'l_I
o= Writable SmartInsert | 66:2 |

2.4 Debug application code

2.4.1 Create a debug launch configuration

To be able to debug the application, you must create a Debug configuration. Open the pulldown menu
of the Debug button:

Figure 2.8. Debug button

i‘ﬁ;ﬂv%*JQE

(o [aumch Ristars

Debug As 3

1

Debug Configurations. ..

Qrganize Favorites... s

and select Debug Configurations.... Highligth Zylin Embedded Debug (Native) and hit the New launch
configuration similarly as you did when creating an External Tools configuration.

Fill in as shown below:
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Figure 2.9. Debug launch configuration details

& Debug Configurations

Create. manage. and run configurations

i= =+l
CEx|B5-

Mame: | blink

|ty|:ue filter text

Main f&? Debuggerw | Commands\l E,_// Source\l m Enuironmen’?l =] Qommnn\l
o E C/C++ Attach to Local Application

i-[€] €/C++ Local Application Project (optional):

I -[E ] CjC++ Postmortem debugger | hlink Browse. .. |

Zvylin Embedded debug (Cyagwin) o
CfC++ Application:

Zylin Embedded debug (Mative) Ic R

‘26 Debug blink | codesourceryfexe blink.out Search Project... | Browse. .. |

[~ Application console

Apply | Revert |

Filter matched & of 7 items

(7) Debug I Cloze |

Do the following modifications in the other tabs:

» Debugger tab: Enter arm-none-eabi-gdb in the GDB debugger field.
» Debugger tab: Clear GDB command file field.
* Commands tab: Enter

target renote :2331

set tdesc filenanme ../ CortexCpuRegs/target.xm
set mem i naccessi bl e-by-default off

set renmote menory-read- packet-size 1200

set renote nmenory-read- packet-size fixed

nmon speed 4000

mon endian little

mon reset 1

tbreak main

cont

in the 'Initialize' commands field. Consult gdb's manual for an explanation of these commands,
mon is shorthand for monitor. Gdb will pass monitor commands directly to the debug server.
Consult SEGGER's J-Link GDB server manual for these commands. The set tdesc filename
command makes Eclipse's cpu register view look nicer. The xml-files needed for this is included in
an0023_efm32_eclipse_toolchain.zip. Put them in a directory named CortexCpuRegs at the same
directory level as your blink project directory.

e Common tab: Check Debug checkbox in the Display in favorites menu frame.

Now you can start debugging your code by selecting blink from the Debug button dropdown menu.
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Figure 2.10. A typical debug session launch

&= Debug - blink/blink.c - Eclipse Platform - |EI|5|

File Edit Refactor Mavigate Search Project Rum  Window Help

-l e ®s-0-@- [ ®a 7-[[4]8 -6 -0 G- - 5 [ 45 pebug T clc++

%5 Debug 32 = B ||¢= variables (00 Breakpoints ﬂﬂﬂ Registers &4 =i Modules\l =8
O S S-S S =
=~ ;:_G Debug blink [Zylin Embedded debug (Native]] MName | Value :I
1§ Embedded GDB (30.09. 10 14:12) (Suspended) =l 8t Main ”

i El-gf® Thread [1] (Suspended) et rd 0
“~= 1main{) c:\program files (x38)\energy microlefm32 gecko dk\board Hiige! 0 -
“opi| arm-none-eabi-gdb (30.09.10 14:12) 4 s | o LIJ
5 | 2l _|:I

omete (Diklin, =O|Eotme st o RN e~ o0

# @brief Main function =y Al stdint.h
e e o e o e o e s e o e o e e e o e e e o e e e o e o e o e o e o e o e e e e e e e e de e de R de ke ke e de e de el SR e 4l stdbool.h
int main (veidy e s chip.h
L = A efm3zh
I int coumt = 0; e A leds.h
f* Chip errata */ ol e @ " msTicks : volatile uint32_t
CHIP init(): _I ------ @ SysTick_Handler{void) : void
------ @ Delay(uint32_t) : void
/* Ensure core fregquency has been updated */ = ol e @ main(void) : int
Suratemtnre” larkTmdatrs () - =
dl | _>l_I
El console &2 %Tasks}&ﬁoblems}ﬁﬁrembHes}ﬂMemorﬂ [T hll:-'x 5@|E£H,—‘||§||@| ] = - rﬁ'mﬁ
Debug blink [Zylin Embedded debug (Native)] arm-none-eabi-gdb (30.09. 10 14:13)
target remote :2331 1=
000000000 in _ cs3_interrupt vector efm32g ()
zet tdesc filename ../ /eclipsexml/target.xml
zet mem inaccesszible-by-default off

zet remote memory-read-packet-size 1200
zet remote memory-read-packet—-size fixed
mon speed 4000

JTAG speed set to 4000 kHz

mon endian little

Target endianess =zet to "little endian”™
mon reset 1

Resetting target (halt with breakpoint @ address 0)

threak main
Temporary breakpoint 1 at Oxa36: file ../blink.c, line 64.

cont

Temporary breakpoint 1, main () at ../blink.c:64

64 int count = 0; —
-

& ¥

[ S ‘ Writable ‘ Smart Insert ‘ 5411 |

2.4.2 Run, Stop, Single-Step, Breakpoints

Look for the buttons shown in the figure below in the debug tab.
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Figure 2.11. Debug button

i 3

G e T =

Resume (F&) |StE|:| Into {F5}| /‘\hnsh'ucﬁun Stepping Mude|
Suspend |5tep Over (Fa) |
[Terminate (Ctrl+F2)| [Step Return (F7)|

These are all you need to do simple debugging. Breakpoints are set by doubleclicking in the left gutter
in the source code tab. Set a breakpoint on the Delay(100) function call in the end of main() in blink.c,
hit F8 several times and observe how the LED's on the STK blink. (Hint: You must Terminate before
reflashing and starting a new debug session. Exit and restart the GDB server if you get stuck).

Figure 2.12. Debug with breakpoint

& Debug - blink/blink.c - Eclipse Platform -0l x|
File Edit Refactor MNavigate Search Project Run  Window Help
Ici-Clal@ls-0-&- ™o - 48 -3 -G E | %5 Debug EEjcle++
%5 Debug 2 ;3 ~c§" (B | Fh T = | i# 7% ¥ = B |[ed= variables (99 Breakpaints | i1) Registers 53 ﬂl\"loduleq =0
E- ;:!: blink [Zylin Embedded debug {(MNative)] e = =
El @ Embedded GDE (30,09, 10 15:16) (Suspended) Name I Value N
E-of® Thread [1] (Suspended: Breakpaint hit.) = &8 Man
= 1main() c:\proaram files (x86)\eneray microlefm32 gecko dk\boards\efm32_ax 1w o B —
s o101
“pe| arm-none-eabi-gdb (30.09.10 15:16) 1010
il 1 11
ol r2 4
ol r3 5

Jd |

0/ 15

d I 2l
| & Makefile ] blink.c £2 = O [ 5= outline 2 Disassemuﬂ B R e~
R 2 8 swinth
n
int main(void) J;J sb?lbool.h
{ #  chip.h
n
int count = 0: 4 efm3Zh
f* Chi ! M leds.h
/% Chip crrata */ Py s ¢ volatie Uitz ©
CHIP init(); msTicks @ volatile uint32_
- @  SysTick_Handler{void) : void
° ) « voi
/* Ensure core frequency has been updated */ Del.ay{m.ntBZ__t) void
@ main{void) : int

SyvstemCoreClockUpdate ()
/* Setup S5ysTick Timer for 1 msec interrupts */
if (SysTick Config(SystemCoreClock / 1000)) while (1)

J# Initialize LED driwver #*/
LED Init(}:
/* Infinite loop */
while (1)
{
LED Value {count);
count++;
Delay (100) -

) -
< | _’I—I
El conscle 2 E.Tasks}lg_gproblems\laExembbles\l a Memory\l X 5 | Exe 5@ | SIT_,_E LEI ||§||@| = E-r5-7=0
blink [Zylin Embedded debug (Mative)] arm-none-eabi-gdb (30.09. 10 15:16)
TCmEO T O Y DT COROe e o CoUe S LIiT v r 7 I LI Ty LI T ﬂ
cont
Temporary breakpoint 1, main () at ../blink.c:64
a4 int count = 0;

-
4] »
[ Writable SmartInsert | 80:1 |
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2.4.3 Using EmbSys Register viewer

The register viewer is a practical tool when you are debugging code for the peripherals of the
microcontroller. The register viewer also contain documentation on peripheral registers and their bitfields
(as tooltips). Open Preferences in Eclipse's Window pulldown menu and select the correct device as
shown in the figure below.

Figure 2.13. EmbSys register viewer device selection

=[]
[type fiiter text EmbSys Register Yiew I
(- General A Periperal Register View for embedded system
= C/C++
- Appearance Architecture: r— Chip description
-~ Buid Console Product Features -
- Build Variables Icorbex—m3 j « ARM Cortex-M3 CPU platform —
- Code Style Vendar: « High PerFormam_:e 32-I:_:it processaor @ up to 32 MHz
=1 Deb - + Memory Protection Unit
= E g ) ) IEHEFQYMIUO j » Wake-up Interrupt Controller
Breakpoint Actions = « Flexible Energy Management System
- Comman Source Looku Chip: « 20 NA @ 3V Shutoff Mode
- Debugger Types IEFmgzggggFuB j + 0.6 pA @ 3V Stop Mode, incduding Power-on Reset, Brown-out
EmbSys Register View Detector, RAM and CPU retention
_____ puees I - Board: + 0.9 pA @ 3V Deep Sleep Mode, induding Real Time Clock with
) ﬂ 32,768 kHz osdillator, Power-on Reset, Brown-out Detector, RAM
- Editor | none — and CPU retention |
- Environment » 45 pAMHz @ 3 V Sleep Mode
- File Types « 180 pAMHz @& 3 ¥ Run Mode, with code executed from flash
- Indexer » 128/64/32 KB Flash
. » 16/16/8 KB RAM
-~ Language Mappings « 90 General Purpose If0 pins
[+ Make + Configurable Push-pull, Open-drain, pull-up/down, input filter,
- Mew COT project wizard drive strength _
- Property Pages Settings « Configurable peripheral IIC_J locations
. + 15 asynchronous external interrupts
-~ Task Tags + 8 Channel DMA Controller
- Template Default Values « 8 Channel Peripheral Reflex System for autonomous inter -peripheral
[+ Help signaling
- InstallUpdate « Hardware AES with 128/256-bit keys in 54/75 cydes
- Run/Debu + Timers/Counters
g » 3= 16-bit Timer fCounter
- Tasks « 3x%3 Compare/Capture/PWM channels
[+ Team « Dead-Time Insertion on TIMERD
[+~ Usage Data Collector j
< i B
(7 oK I Cancel |

To open a register viewer in the debug view, select Show View -> Other... in Eclipse's Window pulldown
menu. Then expand the Debug node and select EmbSys Registers.
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Figure 2.14. EmbSys register viewer in action

& Debug - blink/blink.c - Eclipse Platform _ ||:||1|

File Edit Refactor MNavigate Search Project Run Window Help

[Nt @3- 0-@-|@e -] ¢ |Jg-nl-n e - | %5 pebug [@clc+

35 Debug | B! EmbSys Registers 53 = 8|ed=va (ee Br (H'H' Re &3 =ome| — O :
Arch: cortex-m3 Vendor: EnergyMicro Chip: EFM32G890F128 Board: -—— none — =k O =
er | Hex | Bin | Reset | Access I Address I Descri AI 2
= " - MName | Value || .
PB_DOUTTGL - write only - write only 0x00000000 WO 0x4000603C  PortD e — 33
PE_DIN 0x00000000 RO 0x40006040  PortD ERiti ""::'” B
P8_PINLOCKN 0XO000FFFF RW  Ox40006044 | PortU s i i
PC_CTRL 0x00000000 RW  0x40006048 PortC i 11 R ]
PC_MODEL 0x00000000 RW | 0x4000604C  PortP o = B a
[l [5] PC_MODEH 0x00000000 RW  Ox40006050 | PortP an = B
[=] MoDEs (its 0-3) oot ré 16
[*] MoDEs (its 4-7) oioi 15 18
[=] MODE10 (bits 8-11) o il 16 L
7] MoDE11 (hits 12-15) bibi r7 53688
[*] MoDE12 (hits 16-19) oioi 18 32000
[] MODE13 (bits 20-23) ot e 32768
[*] MoDE 14 (hits 24-27) oror 110 0
[=] MODE15 (bits 28-31) o r11 0
Bl [%] pc_pout 0x00000007 | 000D00000DO000000000000000000111 | 0x00000000 RW  0x40006054 | Po )
=] pouT its 0-15) 0x0007 000D00D000000111 Lo tods
PC_DOUTSET - write only - write only 0x00000000 WO | 0x40006058  Po Value, Desaription
PC_DOUTCLR - write only - write only 0x00000000 WO 0x4000605C  Po 0x00, DISABLED - Input disabled. PL_.lIIup if DOUT is set.
=] PC DOUTTGL ~ write only - irite onl 0x00000000 WO | 0x40006060 | P 0x01, INPUT - Input enabled. Filter if DOUT is set
- Write onty Write onty X * ' 0x02, INPUTPULL - Input enabled. DOUT determines pull dire
PC_DIN 0x00000000 RO 0x40006084  Po 0x03, INPUTPULLFILTER - Input enabled with filter. DOUT de
PC_PINLOCKN 0XO000FFFF RW  Ox40006068 | Po 0x04, PUSHPULL - Push-pull output
PD CTRL 0x00000000 RW  Ox4000605C  Po 0x05, PUSHPULLDRIVE - Push-pull output with drive-strengt
= - 0x06, WIREDOR - Wired-or output
PD_MODEL 0x00000000 RW  0x40008070  Pol  pyn7, WIREDORPULLDOWIN - Wired-or output with pull-dowr
PD_MODEH 0x00000000 RW  0x40005074  Po 0x08, WIREDAND - Open-drain output
j Tlon noumr nunnnnrlnnn ow | rvannnenTe | o 0x09, WIREDANDFILTER - Open-drain output with filter
1 0x0A, WIREDANDPULLUP - Open-drain output with pullup
= = — 0x0B, WIREDANDPULLUPFILTER - Open-drain output with fil
[€] blink.c 22 _FEl leds.c 1 O || 5% outline &2 i 0x0C, WIREDANDDRIVE - Open-drain cutput with drive-strer
- . _ 0x0D, WIREDANDDRIVEFILTER - Open-drain output with filts
;I W stdinth 0x0E, WIREDAMNDDRIVEPULLUP - Open-drain output with pul
/% Initialize LED driver #/ 0x0OF, WIREDANDDRIVEPULLUPFILTER. - Open-drain output \
LED Init();

F Infinite loop */
while (1)

{ @ " meTicks : volatie uint32_t
LED Value(count); @  SysTick_Handler{void) : void
count++; @ Delay{uint32_t) : void

Delay(100) ; @ mainvoid) : int

Double click on a register to start viewing its content. Registers which you have selected get a green font.
Changes in register contents are shown with red values. When hovering over a register's description
column you see documentation for that register.

2.4.4 Using the Memory viewer

Eclipse's memory monitor view is a default part of the debug view. The figure below shows two active
memory monitors, one at address 0x20000200 and one at current stackpointer address. The view uses
the Split Pane functionality, which in this case give you one hexadecimal rendering, and one ASCII
rendering. New monitors are added by clicking the green plus sign as indicated.
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Figure 2.15. Eclipse Memory Monitor
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3 Eclipse summary

This application note has gone through the basic steps of installing, configuring and using Eclipse as
a code development environment for writing programs for EFM32 microcontrollers. Keep in mind that
Eclipse is an advanced tool with virtually hundreds of menus with configuration options. The reader is
encouraged to experiment further to finetune Eclipse. Use a search engine on the internet and you will
find lots of articles, tutorials and books on using Eclipse.
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4 Revision History
4.1 Revision 1.04

August 30th, 2011.

Fixed Zylin update link.
4.2 Revision 1.03

June 28th, 2011.

Fixed typo regarding EMEclipseSupport.zip to an0023_efm32_eclipse_toolchain.zip renaming.
4.3 Revision 1.02

March 24th, 2011.

Changed the name of the zip file EMEclipseSupport.zip to an0023_efm32_eclipse_toolchain.zip on
section 1.2.4

4.4 Revision 1.01

November 22nd, 2010.
Added comment about the necessity of having Java installed before installing Eclipse.

4.5 Revision 1.00

November 10th, 2010.

Initial revision.
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A Disclaimer and Trademarks

A.1 Disclaimer

Energy Micro AS intends to provide customers with the latest, accurate, and in-depth documentation
of all peripherals and modules available for system and software implementers using or intending to
use the Energy Micro products. Characterization data, available modules and peripherals, memory
sizes and memory addresses refer to each specific device, and "Typical" parameters provided can and
do vary in different applications. Application examples described herein are for illustrative purposes
only. Energy Micro reserves the right to make changes without further notice and limitation to product
information, specifications, and descriptions herein, and does not give warranties as to the accuracy
or completeness of the included information. Energy Micro shall have no liability for the consequences
of use of the information supplied herein. This document does not imply or express copyright licenses
granted hereunder to design or fabricate any integrated circuits. The products must not be used within
any Life Support System without the specific written consent of Energy Micro. A "Life Support System"
is any product or system intended to support or sustain life and/or health, which, if it fails, can be
reasonably expected to result in significant personal injury or death. Energy Micro products are generally
not intended for military applications. Energy Micro products shall under no circumstances be used in
weapons of mass destruction including (but not limited to) nuclear, biological or chemical weapons, or
missiles capable of delivering such weapons.

A.2 Trademark Information

Energy Micro, EFM32, EFR, logo and combinations thereof, and others are the registered trademarks or
trademarks of Energy Micro AS. ARM, CORTEX, THUMB are the registered trademarks of ARM Limited.
Other terms and product names may be trademarks of others.
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B Contact Information

B.1 Energy Micro Corporate Headquarters

Postal Address Visitor Address Technical Support
Energy Micro AS Energy Micro AS support.energymicro.com
P.O. Box 4633 Nydalen Sandakerveien 118 Phone: +47 40 10 03 01
N-0405 Oslo N-0484 Oslo

NORWAY NORWAY

www.energymicro.com
Phone: +47 23 00 98 00
Fax: + 47 23 00 98 01

B.2 Global Contacts

Visit www.energymicro.com for information on global distributors and representatives or contact
sales@energymicro.com for additional information.

Americas ‘ Europe, Middle East and Africa ‘ Asia and Pacific

www.energymicro.com/americas ‘ www.energymicro.com/emea ‘ www.energymicro.com/asia
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